Public Health Information Network Messaging System (PHINMS) 3.0
Implementation Guide

Version 3.0

Prepared by:
Centers for Disease Control and Prevention

September 21, 2017
EXECUTIVE SUMMARY

Many organizations work together to protect and advance public health. These organizations need to use the internet to securely exchange sensitive data among various public health information systems. The exchange of data, also known as "messaging," is enabled through electronic messages created by using special file formats and a standard vocabulary. The exchange uses a common approach to security and encryption, methods for dealing with various firewalls, and internet protection schemes. The system provides a standard way of ensuring that messages are routed securely while providing a consistent confirmation of message exchange.

The Public Health Information Network Messaging System (PHINMS) sends sensitive data to and receives sensitive data from public health information systems through the internet by using secure Electronic Business Extensible Markup Language (ebXML).

The PHINMS Implementation Guide provides instructions for installation and basic configuration of the PHINMS software; advance configuration procedures are located in the PHINMS Technical Guide.
## REVISION HISTORY

<table>
<thead>
<tr>
<th>VERSION #</th>
<th>IMPLEMENTER</th>
<th>DATE</th>
<th>EXPLANATION</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>Joseph Mai</td>
<td>06-02-2017</td>
<td>Implemented 3.0 Implementation Guide</td>
</tr>
<tr>
<td>1.1</td>
<td>Charlie Peng</td>
<td>06-14-2017</td>
<td>Addition and proofreading</td>
</tr>
<tr>
<td>1.2</td>
<td>Regina Collins</td>
<td>07-03-2017</td>
<td>Addition and proofreading</td>
</tr>
<tr>
<td>1.2</td>
<td>Jannie Williams</td>
<td>08-15-2017</td>
<td>Updates</td>
</tr>
<tr>
<td>1.3</td>
<td>Regina Collins</td>
<td>09-14-2017</td>
<td>Proofreading</td>
</tr>
</tbody>
</table>
# TABLE OF CONTENTS

1.0 Introduction ......................................................................................................................... 9  
  1.1 References ...................................................................................................................... 9  
  1.2 Communiqués ................................................................................................................. 9  

2.0 INSTALLATION REQUIREMENTS ....................................................................................... 10  
  2.1 PHINMS 3.0 Tests .......................................................................................................... 10  
  2.2 System Requirements ..................................................................................................... 10  
  2.3 Apply for a Digital Certificate ....................................................................................... 11  
  2.4 Request PartyID ............................................................................................................. 11  

3.0 DOWNLOAD AND INSTALL THE PHINMS SOFTWARE ................................................. 11  

4.0 UPGRADE PHINMS SOFTWARE ......................................................................................... 21  

5.0 CONFIGURE SQL DATABASES ............................................................................................. 29  

6.0 SENDER INFORMATION ...................................................................................................... 30  
  6.1 Ping Loopback .............................................................................................................. 31  
  6.2 Configure CDC Staging Receiver Route Map ............................................................... 33  
  6.3 Ping a Valid PHINMS Route .......................................................................................... 36  
  6.4 Email CPA File ............................................................................................................ 38  
  6.5 Export the CPA file ...................................................................................................... 38  
  6.6 Send Test Payload Message ....................................................................................... 40  

7.0 RECEIVER INFORMATION .................................................................................................. 43  
  7.1 Configure WorkerQ ...................................................................................................... 43  
  7.2 Create Service and Action Pair ..................................................................................... 47  

8.0 UNINSTALL PHINMS 3.0 ...................................................................................................... 50  

9.0 ADDITIONAL FEATURES .................................................................................................. 52  
  9.1 Import CPA ................................................................................................................... 52  
  9.2 View Receiver Logs .................................................................................................... 52  
  9.3 View Sender Logs ........................................................................................................ 52  
  9.4 Import Trusted Certificate ........................................................................................... 53  
  9.5 Import JDBC JAR Files ............................................................................................... 53  
  9.6 Change Login Password ......................................................................................... 53  
  9.7 Sender and Receiver Alarms ..................................................................................... 54  
  9.8 Alarm Resolution ....................................................................................................... 54  
  9.9 Folder-Based Polling .................................................................................................... 56  
  9.10 Transport Queue Auto Delete .................................................................................. 57  
  9.11 Worker Queue Auto Delete .................................................................................... 57  
  9.12 Secondary Receiver Decryption Certificate ............................................................. 58  
  9.13 Secondary Sender Certificate ................................................................................. 58  
  9.14 VeriSign LDAP Functionality .................................................................................. 59
LIST OF FIGURES

Figure 3.1. Log On Dialog Box .................................................................................................... 11
Figure 3.2. PHINMS 3.0 FTP Downloads .................................................................................. 11
Figure 3.3. FTP Log On Dialog Box .......................................................................................... 12
Figure 3.4. PHINMS 3.0 FTP Windows Build ......................................................................... 12
Figure 3.5. Installation Wizard Preparation Screens ................................................................. 13
Figure 3.6. End User Licensing Agreements Screen ................................................................. 13
Figure 3.7. User Data Screen To Select Installation Type ......................................................... 14
Figure 3.8. Target Path Screen .................................................................................................. 14
Figure 3.9. PartyID and Domain Name Screen .......................................................................... 15
Figure 3.10. Port Numbers Screen ........................................................................................... 15
Figure 3.11. Register this PHINMS instance with PHIN/CDC ................................................. 16
Figure 3.12. Installation Package Screen ................................................................................... 16
Figure 3.13. Installation .............................................................................................................. 17
Figure 3.14. Setup Shortcuts ..................................................................................................... 17
Figure 3.15. PHINMS Installation Options ............................................................................... 18
Figure 3.16. PHINMS Processing ............................................................................................ 18
Figure 3.17. PHINMS Installation Finished ............................................................................. 19
Figure 3.18. PHINMS Console Login Screen .......................................................................... 19
Figure 3.19. PHINMS Console ............................................................................................... 20
Figure 4.1. Install Shield Wizard Preparation Screens ............................................................. 21
Figure 4.2. End User Agreement Screen ................................................................................... 21
Figure 4.3. New Installation or Upgrade Screen ....................................................................... 22
Figure 4.4. Target Path Selection ............................................................................................. 22
Figure 4.5. The Upgrade Location ............................................................................................ 23
Figure 4.6. Port Numbers Screen ............................................................................................ 23
Figure 4.7. Installation Package Screen .................................................................................... 24
Figure 4.8. Installation ............................................................................................................... 24
Figure 4.9. Setup Shortcuts ...................................................................................................... 25
Figure 4.10. PHINMS Installation Options ............................................................................. 25
Figure 4.11. PHINMS Processing ............................................................................................. 26
Figure 4.12. PHINMS Installation Finished ............................................................................. 26
Figure 4.13. PHINMS Console Login Screen .......................................................................... 27
Figure 4.14. PHINMS Console ............................................................................................... 27
Figure 6.1. CDC PHINMS Topology ....................................................................................... 29
Figure 6.2. PHINMS 3.0 Console ............................................................................................ 30
Figure 6.3. PHINMS Ping ......................................................................................................... 30
Figure 6.4. Ping Message ......................................................................................................... 31
Figure 6.5. PHINMS 3.0 Console ............................................................................................ 32
Figure 6.6. Sender Configuration ............................................................................................. 32
Figure 6.7. Route Map Item ................................................................. 33
Figure 6.8. CDC Route Map Configuration ........................................ 33
Figure 6.9. Sender Configuration .......................................................... 34
Figure 6.10. CDC Route Configuration Successful ........................... 34
Figure 6.11. Restart PHINMS Console ............................................... 35
Figure 6.12. PHINMS 3.0 Console ......................................................... 35
Figure 6.13. PHINMS Ping ................................................................. 36
Figure 6.14. Ping Message ................................................................. 36
Figure 6.15 PHINMS Tools Option ...................................................... 37
Figure 6.16. Export Route CPA .......................................................... 38
Figure 6.17. PHINMS 3.0 Console ......................................................... 39
Figure 6.18. PHINMS Send Message .................................................. 39
Figure 6.19. Security Options .............................................................. 40
Figure 6.20. Send Message ................................................................. 41
Figure 6.21. Message Sent Confirmation ........................................... 41
Figure 7.1. PHINMS 3.0 Console .......................................................... 42
Figure 7.2. Receiver Configuration - Database ..................................... 42
Figure 7.3. Database Item ................................................................. 43
Figure 7.4. Queue Maps ................................................................. 44
Figure 7.5. Queue Map Item .............................................................. 44
Figure 7.6. WorkerQ Database Configuration Successful .................... 45
Figure 7.7. PHINMS 3.0 Console ......................................................... 45
Figure 7.8. Service Map ................................................................. 46
Figure 7.9. Service Map Item ............................................................ 46
Figure 7.10. Service and Action Added ............................................. 47
Figure 7.11. Service and Action Successful Configuration .................. 47
Figure 7.12. Service Map Item .......................................................... 48
Figure 8.1. PHINMS Uninstaller screen ............................................. 48
Figure 8.2. Application Uninstaller .................................................... 49
Figure 8.3. Successful Uninstall ......................................................... 49
Figure 8.4. PHINMS install directory .................................................. 49
Figure 9.1. Alarms ................................................................. 53
Figure 9.2. Alarm Resolution ............................................................ 53
Figure 9.3. Alarm Successfully Processed .......................................... 54
LIST OF TABLES

Table 1. References ........................................................................................................ 9
Table 2. JDBC Drivers .................................................................................................. 10
Table 3. SDN PHINMS Digital Certificate Activities ..................................................... 11
Table 4. WorkerQ Database Tag Values........................................................................ 46
# ACRONYM LIST

<table>
<thead>
<tr>
<th>Acronym</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CDC</td>
<td>Centers for Disease Control and Prevention</td>
</tr>
<tr>
<td>CPA</td>
<td>Collaboration Protocol Agreement</td>
</tr>
<tr>
<td>CPS</td>
<td>Certification Practice Statement</td>
</tr>
<tr>
<td>ebXML</td>
<td>Electronic Business Extensible Markup Language</td>
</tr>
<tr>
<td>FAQs</td>
<td>Frequently Asked Questions</td>
</tr>
<tr>
<td>FTP</td>
<td>File Transfer Protocol</td>
</tr>
<tr>
<td>HF3</td>
<td>Hot Fix 3 (installs with 32 and 64 bit versions of java)</td>
</tr>
<tr>
<td>JDBC</td>
<td>Java Database Connectivity</td>
</tr>
<tr>
<td>LDAP</td>
<td>Lightweight Directory Access Protocol</td>
</tr>
<tr>
<td>PC</td>
<td>Personal Computer</td>
</tr>
<tr>
<td>PartyID</td>
<td>Party Identifier</td>
</tr>
<tr>
<td>PHINMS</td>
<td>Public Health Information Network Messaging System</td>
</tr>
<tr>
<td>PHINMSG</td>
<td>Public Health Information Network Messaging</td>
</tr>
<tr>
<td>RDBMS</td>
<td>Relational Database Management System</td>
</tr>
<tr>
<td>SDN</td>
<td>Secure Data Network</td>
</tr>
<tr>
<td>SP1</td>
<td>Service Pack 1</td>
</tr>
<tr>
<td>SQL</td>
<td>Structured Query Language</td>
</tr>
<tr>
<td>SSL</td>
<td>Secure Socket Layer</td>
</tr>
<tr>
<td>TLS</td>
<td>Transport Layer Security</td>
</tr>
<tr>
<td>TransportQ</td>
<td>Transport Queue</td>
</tr>
<tr>
<td>URL</td>
<td>Uniform Resource Locator</td>
</tr>
<tr>
<td>WorkerQ</td>
<td>Worker Queue</td>
</tr>
</tbody>
</table>
1.0 INTRODUCTION

The Public Health Information Network Messaging System (PHINMS) Implementation Guide assists users with the installation, configuration, and upgrade of the PHINMS product. It also provides instructions to install and configure PHINMS to send and receive messages from the Centers for Disease Control and Prevention (CDC) and CDC partners.

PHINMS is updated periodically; refer to the PHINMS website at www.cdc.gov/phin/tools/phinms for the most current release of PHINMS software. Information available on the website includes:

- **Overview**: The overview summarizes the purpose of PHINMS and announces new PHINMS features and processes.
- **Installation**: This section of the website provides documentation pertinent to the installation and configuration of the PHINMS software. Other PHINMS documents are also available, such as an acronym and glossary list, web service adapters, and more.
- **Quick Tips for Getting Started**: PHINMS Quick Tips provide an overview of the information needed most often. Quick steps are documented for Release 3.0. Suggestions for additional questions can be sent to the PHINMS website point of contact by using the support tab.
- **FAQs**: The list of frequently asked questions (FAQs) is stored in this section. The list contains answers to many questions users have previously submitted. The PHINMS team welcomes questions, suggestions, and/or comments.
- **Support**: The support section provides contact information for contacting the PHINMS Help Desk, accessing online help, and contacting the website administrator.

### 1.1 References

<table>
<thead>
<tr>
<th>NAME</th>
<th>LOCATION</th>
</tr>
</thead>
<tbody>
<tr>
<td>PHINMS Release Notes 3.0</td>
<td>Description of supported environments, software requirements, explanation of upgrade path, and a list of new features and bug fixes made since PHINMS Release 2.8.00 and PHINMS 2.9.00. One major new upgrade is that PHINMS 3.0.00 implemented CDC’s mandatory security upgrade from TLS 1.0 to TLS 1.2. Located at: <a href="http://www.cdc.gov/phin/tools/PHINMS/installation.html">http://www.cdc.gov/phin/tools/PHINMS/installation.html</a></td>
</tr>
</tbody>
</table>

Table 1 References

### 1.2 Communication with Users

Send questions, suggestions, and/or comments concerning PHINMS support or documentation to the PHINMS website by using the email link located in the **Contact Us** block on the left side of the home page. The PHINMS team responds to users’ communications.
2.0 INSTALLATION REQUIREMENTS

2.1 PHINMS 3.0 Tests

PHINMS 3.0 has been tested on the following:

- Operating systems with 32- or 64-bit version of Java installed:
  - Windows 2008 Server (Standard or Enterprise) SP2
  - Windows 7
- Certified Default Database:
  - HSQL DB 1.8.0.4
  - Production Qualified Databases:
    - Microsoft SQL Server 2008
    - MySQL 5.0
    - Oracle 11g Release 1
- Application Servers:
  - Tomcat 8
- Proxy Servers:
  - IIS 7.5 with Web logic 10.3.6.

PHINMS 2.8 and/or later have tested the Java Database Connectivity (JDBC) drivers to connect to the supported databases shown in Table 2. Based on these tests, no issues were found. PHINMS does not guarantee or support the JDBC drivers shown below. It is up to the PHINMS customer to decide which JDBC driver to use. The table is provided for reference only.

<table>
<thead>
<tr>
<th>DB SERVER</th>
<th>VERSION</th>
<th>JDBC DRIVER NAME</th>
<th>TYPE</th>
<th>VERSION</th>
<th>DATE</th>
</tr>
</thead>
<tbody>
<tr>
<td>MS SQL</td>
<td>2005</td>
<td>sqljdbc.jar</td>
<td>4</td>
<td>1.2.2828</td>
<td>10/11/2007</td>
</tr>
<tr>
<td>MS SQL</td>
<td>2008</td>
<td>sqljdbc4.jar</td>
<td>4</td>
<td>2.0</td>
<td>03/25/2009</td>
</tr>
<tr>
<td>Oracle</td>
<td>10g Rel 2</td>
<td>ojdbc14.jar</td>
<td>4</td>
<td>10.2.0.2</td>
<td>01/22/2006</td>
</tr>
<tr>
<td>Oracle</td>
<td>11g Rel 1</td>
<td>ojdbc6.jar</td>
<td>4</td>
<td>11.1.0.7.0</td>
<td>08/28/2008</td>
</tr>
<tr>
<td>MySQL</td>
<td>5.0.67</td>
<td>mysql-connector-java-5.1.6-bin.jar</td>
<td>4</td>
<td>3.51.27</td>
<td>11/20/2008</td>
</tr>
</tbody>
</table>

Table 2. JDBC Drivers

2.2 System Requirements

The installation of PHINMS 3.0 system requirements is as follows:

- Windows OS with Java 7
- 1024 MB of disk space
- 2 GB of memory
- Local administrator privileges
- System administrator privileges on Windows.
Ensure that all the correct ports—which may be 5088 (default local host port), 443 (Secure Socket Layer [SSL]) - Hyper Text Transfer Protocol over Secure Sockets Layer (HTTPS), and 389 (Lightweight Directory Access Protocol [LDAP])—are open on the firewall.

Once the requirements above have been met, proceed to Section 2.3, which can be performed simultaneously with Section 2.4.

2.3 Apply for a Digital Certificate

PHINMS users who send data to CDC are required to have a digital certificate. To obtain a certificate, contact the PHIN Help Desk at PHINtech@cdc.gov. Information about digital certificates is available in the Digital Certificate Policy section on the PHINMS website.

2.4 Request PartyID

To obtain the PHINMS software, email the PHIN Help Desk at PHINTech@cdc.gov. Information will need to be provided about the organization(s) that will use the software to send and/or receive messages. This information will be reviewed and confirmed by a PHINMS support team member and the software download link will be emailed to the requestor, along with a PHINMS PartyID.

A unique PartyID is required for every organization sending and receiving messages to CDC. A PartyID uniquely identifies a PHINMS installation, also called an instance or node. The PartyID is included with every message, which informs the recipient of the originator. Contact the PHIN Help Desk at PHINTech@cdc.gov for any issues with the PartyID or if a PartyID is not received following submission of organization information.

The PartyID is required during installation and becomes a permanent, identifying part of the application. The PHINMS application will need to be reinstalled if the PartyID needs to be changed.

Note: If there is a need to install PHINMS at more than one site or to install more than one PHINMS installation at the same site, a unique PartyID is required for each installation.

The recommended way to install PHINMS 3.0 is to download the application from the File Transport Site (FTP) site (Section 3.0). Note: Contact PHINTech@cdc.gov for FTP site login credentials.

3.0 DOWNLOAD AND INSTALL THE PHINMS SOFTWARE

Install PHINMS 3.0 by using the following steps. These steps pertain to new installations; instructions for upgrading an existing installation are in Section 4.0.

Note: Refer to Section 2.4 if an email was not received with the PartyID information.

1. Open any web browser and type the FTP URL into the address bar: ftp://sftp.cdc.gov. This will open a dialog box (Figure 3.1).
2. Enter user name and password, then click Log On. This will open the FTP root directory (Figure 3.2).

Figure 3.2. PHINMS 3.0 FTP Downloads

The above screen capture also will show PHINMS_3.0.00.
3. To view this FTP site in Windows Explorer, enter the link in the Explorer bar and select enter. This will open a dialog box as illustrated in Figure 3.3.

![FTP Log On Dialog Box](image)

Figure 3.3. FTP Log On Dialog Box

4. Enter user name and password, then click Log On. This will open the installation utility illustrated in Figure 3.4.

![PHINMS 3.0 FTP Windows Build](image)

The screen capture will show PHINMS_3.0.00.

Figure 3.4. PHINMS 3.0 FTP Windows Build
5. Double-click on the PHINMS-3.0-install.exe executable file and select Save to save the application to your local computer. The installation wizard will open, as illustrated in Figure 3.5.

![Figure 3.5. Installation Wizard Preparation Screens](image)

6. Click Next. The licensing agreements will open as illustrated in Figure 3.6. The responsibilities of the PHINMS user are listed on this screen.

![Figure 3.6. End User Licensing Agreements Screen](image)
7. Once you have read the terms of the agreement, select “I accept the terms of the license agreement” and click Next. The user data screen will open as illustrated in Figure 3.7. This screen allows the user to select whether they are completing a new installation or an upgrade of an existing installation.

![Image of User Data Screen]

Figure 3.7. User Data Screen To Select Installation Type

8. Select New Install and click Next.

![Image of Target Path Screen]

Figure 3.8. Target Path Screen
9. Click OK to select the default target directory, or click browse to install to a different directory on your local computer. Click OK to proceed. This will open a user data window to enter the domain name and party ID.

![PartyID and Domain Name Screen](image)

Figure 3.9. PartyID and Domain Name Screen

10. Enter the domain name (defined by user, e.g., cdc.gov) and the assigned party ID, and click Next. A user data screen will open requesting the port identification information (Figure 3.10).

![Port Numbers Screen](image)

Figure 3.10. Port Numbers Screen
11. Enter the default PHINMS port numbers: 5088 for HTTP, 5089 for HTTPS, and 6087 for Database. Click Next. The registration screen will open as illustrated in Figure 3.11. It is optional to enter the organization name, administrator name, and email address to register the product with CDC. **Note:** Do not check the box that reads, “I want to register this PHINMS instance with PHINS/CDC.” At the time of this publication, there is no active registration server.

![Registration Screen](image)

Figure 3.11. Registration Screen

12. Click Next. The select installation packages screen will display, as illustrated in Figure 3.12.

![Installation Package Screen](image)

Figure 3.12. Installation Package Screen
13. Select PHINMS Core and click Next. The system will begin installation, as illustrated in Figure 3.13. Progress bars will indicate the status of installation.

![Installation Screen](image)

Figure 3.13. Installation Screen

14. When the installation completes, click Next. The shortcut screen will display, as illustrated in Figure 3.14. This screen displays options to create shortcuts in the PHINMS start menu.

![Setup Shortcuts Screen](image)

Figure 3.14. Setup Shortcuts Screen

Note: Choose default to reset this screen if you make changes and want to undo them.
15. Click Next. A screen with options for final actions will display, as illustrated in Figure 3.15.

![Figure 3.15. PHINMS Installation Options Screen](image)

16. Select how PHINMS is to be installed on your system (i.e., as a service and start console, service only, or not as a service [just install]) and click Next. The processing screen will display, as illustrated in Figure 3.16.

![Figure 3.16. PHINMS Processing Screen](image)
17. Click Next to initiate PHINMS for the first time. The Installation Finished window will display as illustrated in 3.17. Click Done.

**Note:** The console may appear in front of the Installation Finished window. If this occurs, click and drag the console out of the way to click Done in the Installation Finished screen.

![Figure 3.17. PHINMS Installation Finished Screen](image)

18. The PHINMS console login screen will load, as displayed in Figure 3.18.

![Figure 3.18. PHINMS Console Login Screen](image)
18. Enter user name as “system” and password as “Phinms123” and then click Login to access the PHINMS console as displayed in Figure 3.19.

![PHINMS Console](image)

**Figure 3.19. PHINMS Console**

### 4.0 UPGRADE PHINMS SOFTWARE

PHINMS 3.0 allows the user to upgrade from version 2.8.00 and newer. Systems using versions of the PHINMS software earlier than 2.8.00 must perform a fresh install of PHINMS 3.0.

**Note:** The PHINMS upgrade will not overwrite the previous versions. It will install PHINMS 3.0 in a new location and pull the configuration files, mainly the TransportQ table configuration information, and use this information to configure the new PHINMS 3.0 application. This process allows the user to maintain the previous installation in case there are any problems with the new installation.

Complete the following steps to upgrade to version 3.0 from versions 2.8.00 through 2.9. PLEASE FOLLOW THESE STEPS CAREFULLY. You will need to know the file directory location of your existing version of PHINMS to complete this process:

1. If open, close the console for the previous version of PHINMS.
2. Stop the PHINMS services for the previous version of PHINMS (Windows Services).
3. Rename the existing instance of PHINMS to PHINMSold.
4. Open the executable file PHINMS-3.0-install.exe. The Installation Wizard will open (Figure 4.1) and will begin installing PHINMS 3.0.
5. Click Next to proceed to the next step (Figure 4.2).

Figure 4.2. End User Agreement Screen
6. Review the licensing agreement and then select, “I accept the terms of this license agreement.” and click Next to proceed to step 3 (Figure 4.3).

![Figure 4.3. New Installation or Upgrade Screen](image)

7. Select Upgrade 2.8.00 or later and click Next to proceed to step 4 (Figure 4.4).

![Figure 4.4. Target Path Selection Screen](image)
8. Confirm that the default installation path is the same path as the previous version of PHINMS before renaming the directory to PHINMSold. If necessary, click Browse to locate that identical directory. Once the correct directory is in the installation path, click Next to proceed (Figure 4.5).

![Figure 4.5 Selection Screen for Existing PHINSMS Instance](image)

9. Click Browse and find the file location of the old PHINMS instance (PHINMSold). Once the correct directory shows in the selection bar, click Next to proceed (Figure 4.6).

![Figure 4.6. Port Numbers Screen](image)
10. Enter PHINMS default port numbers: 5088 for HTTP, 5089 for HTTPS, and 6087 for the database. Click Next to proceed to the Installation Package screen (Figure 4.7).

![Installation Package Screen](image)

Figure 4.7. Installation Package Screen

11. Select PHINMS Core and click Next to proceed to the installation process (Figure 4.8). The progress bars will illustrate the status of installation.

![Installation Screen](image)

Figure 4.8. Installation Screen
12. Once installation is complete, click Next to proceed to the Setup Shortcuts screen (Figure 4.9). This screen displays options to create shortcuts in the PHINMS start menu.

![Setup Shortcuts Screen](image)

Figure 4.9. Setup Shortcuts Screen

13. Click default if you make changes and want to undo them. Once you have created shortcuts, click Next to proceed to the installation options screen (Figure 4.10).
Figure 4.10. PHINMS Installation Options Screen

14. Select how PHINMS is to be installed on your system (i.e., as a service and start the console, as a service only, or not as a service [just install]) and click Next. The Processing screen will display as illustrated in Figure 4.11.

![PHINMS Processing Screen](image)

Note: The console may appear in front of the Installation Finished window. If this occurs, click and drag the console out of the way to click Done in the Installation Finished screen.

15. Click Next to complete installation (Figure 4.12).
Figure 4.12. PHINMS Installation Finished Screen

Note: The installation has completed successfully. An uninstaller has been created. There is now an option to generate an automatic installation script to deploy PHINMS with the same configuration on another system.

16. Click Done in the installation screen to proceed to the PHINMS login screen (Figure 4.13).

![Figure 4.13. PHINMS Console Login Screen](image)

17. Enter user name and password, then click login to open the PHINMS console (Figure 4.14).
5.0 CONFIGURE SQL DATABASES

A Structured Query Language database (HSQLDB) containing a transport queue (TransportQ) is automatically installed with the PHINMS 3.0 application. An external database can be created for the purpose of hosting the messaging queue tables. PHINMS 3.0 will support the following databases for hosting messaging queues:

- HSQLDB 1.8.0
- Microsoft SQL Server 2005 and 2008
- MySQL 5.0
- Oracle 10g and 11g.

An HSQL database is provided with the PHINMS installation on the Windows platform as a default database and facilitates installation testing. It is recommended that PHINMS users conduct an evaluation of the tradeoffs between SQL and a high transaction-volume relational database management system (RDBMS) such as others listed above.

All table scripts needed for PHINMS external database configurations for the databases listed above will be posted on the FTP site ([ftp://sftp.cdc.gov/PHINMS](ftp://sftp.cdc.gov/PHINMS)). The provided table scripts are for the transport queue, worker queue only.

Note: To use an external database (DB) connection, the appropriate JDBC driver must be imported into PHINMS via the PHINMS Console Tools option (section 9.6). DB drivers can also be found on the FTP site ([ftp://sftp.cdc.gov/PHINMS/PHINMS_Database_Drivers/](ftp://sftp.cdc.gov/PHINMS/PHINMS_Database_Drivers/)). For external DB connection string properties, please refer to the PHINMS Technical Guide.
6.0 SENDER INFORMATION

PHINMS Version 3.0 has two components: the sender and the receiver. Sending a test message allows the PHINMS Sender to send messages to the TransportQ and to CDC. Testing the PHINMS installation is a three-part procedure:

1. Ping the PHINMS Sender loopback route.
2. Ping a configured PHINMS route (Collaboration Protocol Agreement [CPA] files must be imported on the receiving side).
3. Ping the PHINMS CDC Staging Receiver (CPA files must be emailed to Phintech@cdc.gov. See Section 6.4 for more information.).

Figure 6.1 is a topology diagram to help users understand the PHINMS authentication process.

![Figure 6.1. CDC PHINMS Topology](image)
6.1 Ping Loopback

The Ping Loopback validates that the PHINMS installation was downloaded and installed successfully on the sender’s system. This process is not a test to verify that messages can be sent outside of a firewall if one is present.

Verify that the generated Ping Loopback is sent to the loopback message processor successfully by completing the following steps:

1. Open the PHINMS 3.0 Console (Figure 6.2).

![Figure 6.2. PHINMS 3.0 Console](image)

2. Click Ping Message in the top menu bar to display the ping dialog box (Figure 6.3).
3. Select loopback, then click Ping Selected Routes to return to the console with the loopback screen open (Figure 6.4).

4. In the right-hand dropdown menu, select the loopback folder showing the status of the ping.

**Note:** When the Transport status (first column in the status block) lists a status of “queued” or “attempted,” click Refresh in the top menu bar until the status changes.
6.2 Configure CDC Staging Receiver Route Map

The CDC Staging Receiver must be configured before sending a ping. Configure the CDC Staging Receiver by using the steps detailed in this section.

Note: Perform these steps only if sending to CDC. A digital certificate must be obtained before a successful ping test can be sent.

1. Open the PHINMS 3.0 Console (Figure 6.5).

![Figure 6.5. PHINMS 3.0 Console](image)

2. Go to the Configure option in the menu bar and select Sender>Route Map as illustrated in Figure 6.5. This action will open the Sender Configuration screen (Figure 6.6).
3. Select CDCStagingReceiver and then click Update to open the Route Map dialog box (Figure 6.7).

4. Select “clientcert” from the Authentication Type dropdown list. Click OK to return to the Route Map dialog box (Figure 6.8).
5. Enter the (.pfx) path to the stored certificate Key Store. This is the digital certificate issued to the person who will use it to send data to CDC.

6. Enter the associated password in the Password field and click OK to return to the Sender Configuration screen (Figure 6.9).

Figure 6.8. Route Map Item Dialog Box

Figure 6.9. Sender Configuration Screen
7. Click Save to set configuration. If all information has been entered correctly, the system will return a success message (Figure 6.10).

![Figure 6.10. Confirmation that Route Configuration Successful](image)

8. Click OK and restart PHINMS by going to the Configure menu in the PHINMS Console menu and selecting Restart PHINMS (Figure 6.11).

![Figure 6.11. Restart PHINMS Console](image)

**6.3 Ping a Valid PHINMS Route**

The Ping Message validates that the Sender can connect to the Internet and to the selected route. Verify the Ping Message to the selected route is successful by completing the following steps:

1. Open the PHINMS 3.0 Console (Figure 6.12).
2. Select Ping Message in the top menu bar to open the PHINMS Ping screen (Figure 6.13).

3. Select route of choice. This example uses CDCProductionReceiver.
Note: You must have a valid digital certificate configured to ping any route requiring client certificate authentication (see section 6.2).

4. Click Ping Selected Routes to return to the console with the loopback screen open (Figure 6.14).

![Figure 6.14. Ping Message Screen in PHINMS Console](image)

5. In the right-hand dropdown menu, select the loopback folder showing the status of the ping.

Note: When the Transport Status (first column in the status block) lists a status of “queued” or “attempted,” click Refresh in the top menu bar until the status changes.

### 6.4 Email CPA File

PHINMS creates a CPA file for each route listed in the PHINMS Route Map tab of the Sender Configuration panel. The PHINMS administrator must export the CPA for any configured route and send the related CPA to the receiving site to import into the receiving PHINMS console. To send to CDC, export the CPA file and send them for the CDC Production Receiver or the CDC Staging Receiver to the PHINMS Help Desk (Phintech@cdc.gov). Only after the PHIN Help Desk has received the CPA file and applied it to the PHINMS Receiver can messages be successfully transmitted from the sender to the receiver.

The required CPA files are in directory C:\(PHINMS install directory)\config\sender\CPA.

Note: Information on CPA can be found in the PHINMS Technical Reference Guide.

### 6.5 Export the CPA file

1. Open the PHINMS Console. Using the Tools option in the main menu, select Export CPA Files (Figure 6.15).
2. Select the route to export the CPA. For this example, the export is to the CDCStagingReceiver route (Figure 6.16).

3. Click Export Selected Routes.
4. Browse to the location where the CPA file will be exported.
5. Email the CPA xml file to the appropriate receiving site.
6. Once the receiving site has confirmed that the CPA file is imported, use the steps in Section 6.6 to test the route.
6.6 Send Test Payload Message

The Send Payload Message option verifies the capability to send an outbound message with an attached file to a receiver. Users must have received a confirmation that the required CPA files have been sent to the PHIN Help Desk before attempting to send a payload message to CDC. Refer to Section 9.1 for CPA information.

To send the payload message test to the PHINMS Staging Receiver:

1. Open the PHINMS 3.0 Console (Figure 6.17).

![PHINMS 3.0 Console](image)

Figure 6.17. PHINMS 3.0 Console

2. Select New Message from the top menu bar to open the Send Message screen (Figure 6.18).
3. Enter the Send Message parameters provided by the receiving site or, if sending to CDCStaging, use the parameters below:
   - **Route:** CDC Staging Receiver
   - **Service:** test
   - **Action:** send
   - **Message Recipient:** optional - can be left blank
   - **Filename:** browse to the file to be sent to the receiver
   - **Destination Name:** optional - can be left blank
   - **Arguments:** optional - can be left blank.

4. Security options are available for encrypting or signing messages if desired. If using security options, proceed to Step 5. Otherwise, skip to Step 8.

5. Click Security Options to open the Security Options menu (Figure 6.19).
6. Ensure the following defaults if sending to CDC:
   - Encrypt Message is checked
   - Use LDAP lookup to find encryption certificate is selected
   - Address: directory.verisign.com:389
   - BaseDN: o=Centers for Disease Control and Prevention
   - Common Name: cn=cdc phinms

7. Click OK to return to the Send Message screen (Figure 6.20).
8. Click Send. If the message is successfully queued, PHINMS will display a confirmation message (Figure 6.21).

![Message Sent Confirmation](image)

Figure 6.21. Message Sent Confirmation

9. Click OK

### 7.0 RECEIVER INFORMATION

#### 7.1 Configure WorkerQ

The worker queue (WorkerQ) is the database table used for storing inbound messages. When configured from the receiver configuration screen in the console, the WorkerQ is used to store incoming messages sent to the receiver. The database configuration needs to be completed before creating the WorkerQ table. Instructions on how to configure a database connection to the external database are in Section 5.0.

If configured from the sender configuration screen in the console, the WorkerQ is used to write the responses to polling requests (route-not-read configuration). More information on sender configuration is located in the PHINMS Technical Reference Guide.

Create an external database WorkerQ table by using the following steps:

1. Open the PHINMS 3.0 Console (Figure 7.1).
2. Using the Configure dropdown in the main menu, select Receiver>WorkerQueues. The Receiver Configuration screen will open (Figure 7.2).

3. Click Add to open the Database Item screen (Figure 7.3). (A user can also update or delete a database once it is added by using the appropriate buttons in Figure 7.2).
4. Enter the database items. Refer to Table 4 for an explanation of the values.

<table>
<thead>
<tr>
<th>TAG VALUE</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database ID</td>
<td>The unique name for the database connection pool, referenced in the queue map. The service map uses the databaseId to map the queue to a specific database. (The unique databaseId is determined by the user.)</td>
</tr>
<tr>
<td>Database Type</td>
<td>Designates the type of database.</td>
</tr>
<tr>
<td>Database URL</td>
<td>The URL to the database. The URL depends on the type of database and driver used, (e.g., jdbc:sqlserver://host:portnumber;DatabaseName=database for Microsoft SQL Server and jdbc:oracle://host:port:sid for Oracle).</td>
</tr>
<tr>
<td>Database Driver</td>
<td>The type of JDBC driver. The JDBC driver should be appropriate for the type of database, (e.g., com.microsoft.sqlserver.jdbc.SQLServerDriver for Microsoft SQL Server and oracle.jdbc.OracleDriver for Oracle).</td>
</tr>
<tr>
<td>Database User</td>
<td>The database user account is provided by the database administrator for login purposes and to automate the login process via PHINMS. A pointer to the database user entry is in the message receiver's encrypted password store. The value is not the database user but the name of the tag within the password file. The value of the tag contains the actual database user name.</td>
</tr>
<tr>
<td>Database Password</td>
<td>This password is provided as part of the user account created by the database administrator for login purposes and to automate the login process via PHINMS. A pointer to the database password entry is in the message receiver's encrypted password store. The value is not the database password but the tag within the password file. The value of the tag contains the actual database password.</td>
</tr>
</tbody>
</table>
Pool size is the number of database connections to open. When setting the pool size, users should ensure that the system can handle the maximum client load while keeping enough memory available.

| Pool Size | Pool size is the number of database connections to open. When setting the pool size, users should ensure that the system can handle the maximum client load while keeping enough memory available. |

Table 4. WorkerQ Database Tag Values

5. After entering the database items, click Queue Maps to open the Queue Maps menu (Figure 7.4).

![Queue Maps Menu](image)

Figure 7.4. Queue Maps Menu

6. Click Add to open the Queue Map entry screen (Figure 7.5).

![Queue Map Item Entry Screen](image)

Figure 7.5. Queue Map Item Entry Screen

7. Enter the Queue Map ID (determined by the user).
8. Enter Table Name
   » Click OK
» Click OK
» Click OK.

9. Click Save. If configuration was successful, PHINMS will display a confirmation screen (Figure 7.6).

![Figure 7.6. WorkerQ Database Configuration Successful](image)

10. Click OK.

11. Using the Configure option in the PHINMS console main menu, select Restart PHINMS.

### 7.2 Create Service and Action Pair

PHINMS 3.0 uses message envelopes for each sent message. The envelope has address information tags called Service and Action. These tags are known as character strings and are logically mapped to an application queue on the receiving side. The Service and Action tags determine the message type.

Create a Service and Action pair by completing the following steps:

1. Open the PHINMS 3.0 Console (Figure 7.7).

![Figure 7.7. PHINMS 3.0 Console](image)
2. Using the Configure dropdown in the PHINMS console main menu, select Receiver>WorkerQueues to open the Receiver Configuration menu (Figure 7.8). Click the Service Map tab (Figure 7.8).

![Receiver Configuration Menu](image)

Figure 7.8. Service Map Menu

3. Click Add to open the Service Map Item menu (Figure 7.9).

![Service Map Item Menu](image)

Figure 7.9. Service Map Item Menu

4. Enter Service.
5. Enter Action.
6. Select WorkerQueue from the dropdown list.
7. Highlight WorkerQueue in the Q ID column on the left-hand side.
8. Click the Add button located between the two columns.
9. Click OK to return to the Receiver Configuration screen (Figure 7.10). The selected options will appear in the Service Map list.

![Receiver Configuration](image)

Figure 7.10. Confirmation of Service and Action Added

10. Click Save. If the configuration was successful, PHINMS will display a confirmation message (Figure 7.11).

![Message](image)

Figure 7.11. Service and Action Successful Configuration

11. Click OK.
12. Using the Configure option in the PHINMS console main menu, select Restart PHINMS.
**Figure 7.12. Service Map Item**

**Note:** When Payload to Disk is checked in the Service Map Item menu (Figure 7.12), the incoming payload is written to disk instead of to the database field. The default location for payload to disk is (`C:\Program Files\PHINMS\shared\receiverincoming`).

**8.0 UNINSTALL PHINMS 3.0**

Complete the following steps to uninstall PHINMS 3.0:

1. Click the Start button on your computer. Go to All Programs>PHINMS>Uninstall PHINMS. This action will open the DOS menu displayed in Figure 8.1.

**Figure 8.1. PHINMS Uninstaller Screen**
2. The DOS window confirms that the application is removed and deleted. This initiates the application uninstaller screen (Figure 8.2).

![Application Uninstaller](image)

**Figure 8.2. Application Uninstaller**

3. Select “Force the deletion of C:\Program Files\PHINMS (i.e., the PHINMS install directory folder) structure,” then click Uninstall. The middle progress bar will display the status of the uninstall process. When the program is uninstalled, the status bar will read, “Finished” (Figure 8.3).

![Successful Uninstall Confirmation](image)

**Figure 8.3. Successful Uninstall Confirmation**

4. Click Quit.

5. Open the computer’s C: drive and navigate to the PHINMS install directory (Figure 8.4).

![PHINMS Install Directory](image)

**Figure 8.4. PHINMS Install Directory**
6. Delete the PHINMS install directory by clicking on the folder and hitting the delete key on your keyboard. These steps will successfully uninstall PHINMS 3.0.

9.0 ADDITIONAL FEATURES

9.1 Import CPA

PHINMS 3.0 allows the user to import the CPA directly from the PHINMS 3.0 Console. Complete the following steps to import the CPA:

1. Open the PHINMS 3.0 Console.
2. Open the Tools dropdown from the main menu.
3. Click Import CPA.
4. Select the CPA to import.
5. Click Open.
6. Click OK.

9.2 View Receiver Logs

The Receiver Logs store information on the status of received messages and can be viewed directly from the PHINMS 3.0 Console. Viewing the logs allows users to check the status of received messages. Complete the following steps to view the Receiver Logs:

1. Open the PHINMS 3.0 Console.
2. Open the Tools dropdown from the main menu.
4. Select Route from the dropdown list.
5. Select Date.
6. Click View to display the log text.

9.3 View Sender Logs

The Sender Logs store information on the status of sent messages and can be viewed directly from the PHINMS 3.0 Console. Viewing the logs allows users to check the status of sent messages. Complete the following steps to view the Sender Logs:

1. Open the PHINMS 3.0 Console.
2. Open the Tools dropdown from the main menu.
3. Select View Sender Logs.
4. Select Route from the dropdown list.
5. Select Date.
6. Click View to display the log text.
9.4 Import Trusted Certificate

A trusted certificate consists of a root and intermediate certificate authority (CA) certificate. When the browser is trying to make a SSL (secure socket layer) connection, it needs to validate the certificate chain of the SSL certificate installed on the proxy server on the receiver’s end. PHINMS Sender verifies the chain by using CACERTS Key Store file. If the chain does not match, the sender must import the trusted certificate into the CACERTS Key Store file by using an import option. The user can then import the trusted certificate directly from the PHINMS 3.0 Console. Complete the following steps to import the trusted certificate:

1. Open the PHINMS 3.0 Console.
2. Open the Tools dropdown from the main menu.
3. Select Import Trusted Cert.
4. Navigate to the location where the Trusted Certificate is stored.
5. Select the Trusted Certificate (.cer or .pem file) to import.
6. Click Open, then restart PHINMS by going to the Configure menu in the PHINMS Console main menu and selecting Restart PHINMS.

9.5 Import JDBC JAR Files

JDBC Jar Files can be imported directly from the PHINMS 3.0 Console. Complete the following steps to import the three (3) JDBC Jar files:

1. Open the PHINMS 3.0 Console.
2. Open the Tools dropdown from the main menu.
3. Select Import JDBC Jar files.
4. Locate and select the JDBC driver for your database (see Table 1. JDBC Drivers, Section 2.1, page 11 for recommended JDBC drivers).
5. Click Open.
6. A message will indicate a successful import. Click OK.
7. Restart PHINMS Tomcat Instance located in the Windows services console.

9.6 Change Login Password

PHINMS 3.0 allows the user to change the Console login password. Complete the following steps to change the login password:

1. Open the PHINMS 3.0 Console.
2. Open the File dropdown from the main menu.
3. Select Change Login Password.
4. Enter the Old Console Password in the appropriate block.
5. Enter the New Console Password and Re-Enter New Console Password in the appropriate blocks.
6. Click Change Password.
7. Click OK.
8. Restart PHINMS Apache Tomcat service.

9.7 Sender and Receiver Alarms

PHINMS 3.0 contains system alarms for the sender and receiver. This feature allows the user to acknowledge and enter a resolution for each alarm. Configure the alarm features by completing the following steps:

1. Open the PHINMS 3.0 Console.
2. Open the Configure dropdown from the main menu.
3. Select Alarms.

Note: When Report Alarms is selected, the alarms can be viewed in the console and configuration of the Email Alarms feature can be configured.

5. Complete the following fields:
   » SMTP Server - required
   » User Name
   » User Password
   » Re-Enter User Password
   » From Address – required.
6. Click OK.

9.8 Alarm Resolution

The Alarm Resolution feature allows the user to view error and help messages. It also allows the user to store the resolution information. The Alarm Resolution feature can be implemented by using the following steps:

1. Open the PHINMS 3.0 Console.
2. Select Alarms, located at the lower left-hand corner of the console. The Sender Alarms information will display in the main console window (Figure 9.1).
3. Select the message to be reviewed.
4. Select Resolve Alarms to open the Process Alarm screen (Figure 9.2).
5. Review the Error Message and the Suggested Resolution.
6. Enter the name of the person who resolved the alarm in the Resolver Name block.
7. Enter the Resolution in the appropriate block.
8. Click Resolve. PHINMS will confirm successful processing of the alarm (Figure 9.3).

![Figure 9.3. Alarm Successfully Processed](image)

9. Click OK.

10. PHINMS 3.0 also offers the option to delete all alarms by using the Delete All Alarms button in the main alarms window in the Console (Figure 9.1).

### 9.9 Folder-Based Polling

This feature makes it easier for applications to interface with PHINMS 3.0. Senders can configure the console for folder-based polling. This feature allows the sender to store the messages in a folder and the system will send the messages from the folder instead of a database. The associated route is defined in the console and does not need file descriptors. Configure the Folder Based Polling feature by completing the following steps:

1. Open the PHINMS 3.0 Console.
2. Open the Configure dropdown from the main menu.
3. Select Sender>Folder Polling.
4. Check Folder Based Polling.
5. Click Add.
6. Populate the Folder Properties.
7. Select Security Options.
8. Click OK.
9. Click Save.
10. Click OK.
11. Click the PHINMS 3.0 Console Restart button.
12. Create the following three (3) folders in any directory:
   - Outgoing - used to store messages to be sent.
   - Processed - regional file of messages that have been processed.
   - Acknowledgement - stores the message receipt from the receiver.
9.10 Transport Queue Auto Delete

1. Open the PHINMS 3.0 Console.
2. Open the Configure dropdown from the main menu.
3. Select Sender>TransportQueues.
4. Select the Transport Queue to be modified.
5. Click Update.
6. Click Queues for this database.
7. Select the table to be modified.
8. Click update.
9. Locate the auto delete section.
10. Enable Auto Delete.
11. Modify the Frequency to your desired setting.
12. Configure a start date and time.
13. Modify Retention Period to your desired setting.
14. Click OK three times, then click Save.
15. Click OK on the acknowledgement.
16. Click Configure.
17. Click Restart PHINMS.

9.11 Worker Queue Auto Delete

1. Open the PHINMS 3.0 Console.
2. Open the Configure dropdown from the main menu.
3. Select Receiver>WorkerQueues.
4. Select the WorkerQueues to be modified.
5. Click Update.
6. Click Queues for this database.
7. Select the table to be modified.
8. Click Update.
9. Locate the auto delete section.
10. Enable Auto Delete.
11. Modify Frequency to your desired setting.
12. Configure a start date and time.
13. Modify Retention Period to your desired setting.
14. Click OK three times, then click Save.
15. Click OK on the acknowledgement.
16. Click Configure.
17. Click Restart PHINMS.
9.12 Secondary Receiver Decryption Certificate

The new release of PHINMS contains an option to configure a secondary keystore for decrypting files. This option is used when there are two valid certificates on Verisign LDAP. If a sender sends an encrypted file, it is possible that the file will be encrypted with a certificate that has not expired.

The primary and secondary key store locations allow the receiver to configure both new and old certificates. If a file is received encrypted with the new certificate, it will decrypt; if it is encrypted with the old certificate, it will still decrypt until the expiration date is reached.

1. Open the PHINMS Console.
2. Open the Configure dropdown from the main menu.
5. In the Primary Key Store location, enter the path to the new decryption key.
6. Enter the password for the new decryption key.
7. In the Secondary Key Store location, enter the path to the older decryption key.
8. Enter the password.
9. Enter the date the old decryption key expires, in the format yyyy-mm-dd hh:mm:ss.
10. Click Save.
11. Restart PHINMS.

9.13 Secondary Sender Certificate

The new release of PHINMS contains an option to configure a secondary key store for decrypting polled files. This feature is an enhancement for Route not Read (RnR) pollers. This option is used when there are two valid certificates on Verisign LDAP. If a sender sends an encrypted file, it is possible the file will be encrypted with a certificate that has not expired.

The primary and secondary key store locations will allow the poller to configure both new and old certificates. If a file is sent to the RnR hub encrypted with the new certificate, it will decrypt; if it is encrypted with the old certificate, it will still decrypt until the expiration date is reached.

1. Open the PHINMS Console.
2. Open the Configure dropdown from the main menu.
3. Select Sender>General.
5. In the Primary Key Store location, enter the path to the new decryption key.
6. Enter the password for the new decryption key.
7. In the Secondary Key Store location, enter the path to the older decryption key.
8. Enter the password.
9. Enter the date the old decryption key expires, in the format yyyy-mm-dd hh:mm:ss.
10. Click Save.
11. Restart PHINMS.

9.14 VeriSign LDAP Functionality

When LDAP was enabled on previous versions of PHINMS, the application performed a lookup to VeriSign LDAP Services for the data encryption public key and would append the encryption for each message. This constant VeriSign LDAP lookup would periodically fail if the VeriSign LDAP server was not reachable. The LDAP service outage would prevent messages from sending until the outage recovered.

To minimize the VeriSign LDAP dependency, the LDAP lookup feature has been rearchitected, and the PHINMS application has been enhanced to perform a single lookup and then cache the certificate and the expiration date. To maintain secure computing practices, PHINMS performs daily lookups to VeriSign’s CRL (Cert Revocation List) Servers to ensure the cached certificate has not been revoked. The use of the VeriSign CRL Services provides the industry standard security measures for certificate usage.

1. Open the PHINMS Console.
2. Open the Configure dropdown from the main menu.
3. Select Sender>General.
4. Select the LDAP Category.
5. Check Use LDAP Key Retrieval.
6. Click Save.
7. Restart PHINMS.